Instructor DyKnow Tutorial

Getting Started Guide

Instructional Technology Team, College of Engineering

Last Updated: Spring 2019

Email engtechteam@vt.edu if you need additional assistance after reading this document
# Contents

I. Setting Up a Wireless Internet Connection ................................................................. 3

II. How to Get a DyKnow Account .................................................................................. 3

III. Installing and Starting a DyKnow Session ................................................................. 3

IV. Using the Projector Mode ......................................................................................... 7

V. Setting 4:3 Dimension for PowerPoint Prepared Slides .............................................. 8

VI. Working with Prepared Slides .................................................................................. 9

VII. Appending Slides to a Notebook ............................................................................ 10

VIII. Changing a Panel Background .............................................................................. 12

IX. Broadcasting Your Screen ...................................................................................... 13

X. Using Private Ink (Purple Ink) .................................................................................. 15

XI. Working with Layers ............................................................................................... 16

XII. Polling Participants .............................................................................................. 16

XIII. Managing Panels .................................................................................................. 19

XIV. Returning Panels .................................................................................................. 22

XV. Sharing Control ..................................................................................................... 23

XVI. Viewing Session List & Requesting Status ............................................................ 24

XVII. Viewing Activity Level .......................................................................................... 25

XVIII. Creating Work Groups ....................................................................................... 26

XIX. Sharing a Notebook .............................................................................................. 27

XX. Saving a Notebook ................................................................................................. 30

XXI. Retrieving a Notebook Saved on the Server .......................................................... 32

XXII. Using DyKnow Notebook Writer ......................................................................... 32

XXIII. Additional Help .................................................................................................. 33
I. Setting Up a Wireless Internet Connection
   A. An Internet connection is required to use DyKnow. You should be able to browse the web if you are connected to the Internet.
   1. To setup a wireless connection on Virginia Tech’s Campus:
      a. For instructions on how to connect to the “eduroam” network:
         https://guestmanager.cns.vt.edu/guest/launch.php
      b. If you are unable to connect to “eduroam” you may connect to the VirginiaTech SSID by following instructions at https://vt4help.servicenow.com/kb_view.do?sysparm_article=KB0010159

II. How to Get a DyKnow Account
   A. Preferred method: Course request with current CRN
      http://www.eng.vt.edu/dyknow/courserequest
   B. Alternative Method: Email engtechteam@vt.edu, make sure to include PID (not alias).

III. Installing and Starting a DyKnow Session
   A. If you do not have DyKnow installed, you can download the latest version from http://network.software.vt.edu
   1. Enter your PID and password
   2. Click the link that says “DyKnow Software”
   3. Click the link for your operating system, 32-bit or 64-bit
      a. To determine which version of Windows you have:
         i. For Windows 7, go to the Control Panel by selecting the Start button, selecting “Control Panel”, select ‘System and Security’ and then select ‘System.’ Under System, you can view the system type.
         ii. For Windows 8.1, Go to the Control Panel by selecting the Start button, search for “Control Panel”, select ‘System and Security’
and then select ‘System.’ Under System, you can view the system type.

iii. **For Windows 10**, click “Start” or the “Windows” button, go “Settings” 🗼, then “System”, and finally “About”. Under System Type, you can view the system type.

4. Click “Yes, I agree” and then “Accept” the license agreement

5. Follow the installation instructions on the screen.

6. Download and install DyKnow. This may take several reboots to complete the installation.

B. Start DyKnow and log in

1. The user name is your PID.

2. The password for first time users only is your username (PID).

3. Instructors and GTAs can sign on in **student view** using “yourpid”.stu as your username and password (for first time users only).

   ![Sign On](Image)

4. If you are unable to sign on to DyKnow
   a. Make sure you are connected to the internet by opening your web browser
b. Click on the DyKnow logo in the top left hand corner → "Communication Settings" → "Show Classic Communication Settings" to make sure your settings are correct

![DyKnow Options](image)

i. Server Name or IP Address: dyknow.eng.vt.edu

ii. Connection Settings: Select Enable SSL

iii. Port: 443

iv. Click “OK”

5. To request a password reset, go to [https://www.eng.vt.edu/dyknow/reset-your-dyknow-password](https://www.eng.vt.edu/dyknow/reset-your-dyknow-password) and complete the form.

6. Once logged in, click "Start Session" link for the correct class (on the right).
7. A **Start Session** window opens. In the Start Session window, the instructor can:

   a. Select the Prepared Notes by clicking on the browse button in the “Prepared Notes” section of the window to locate and select your prepared notes. Click ‘open’ to select the notes.
      i. If the prepared notes are in PowerPoint format, they are converted to DyKnow (.dyz) presentation file
      ii. If you click “OK” without selecting your prepared notes, you can still open your notes in DyKnow by going to – “File” → “Open” → “Open Prepared Notes”

   b. If you would like to use the ‘Audio Recording’ feature & an audio device is present, please do so by checking the box

8. Click “OK”
9. You are now in a new session. You should see your “Prepared Notes” on the right.

10. To close:
   a. Click the "X" in the top right corner.
   b. Click "Yes" to end the session.
   c. Save if you would like. (Follow the dialogs)

IV. Using the Projector Mode

A. Useful when you want your students to see only the slides
   1. Physically connect your computer to an External Projector
   2. Press the Windows key and ‘P’ on your keyboard
   3. Select the ‘Extended Desktop’ mode
   4. In DyKnow, click on View ➔ Projector Mode
5. In the pop-up screen, make sure ‘Monitor 2’ has the blank screen (you can click on it to swap)

![Projector Mode](image)

6. Click on Start

   *Note: If you find that you accidently projected the wrong screen, do not panic. ☹ Follow your mouse across the extended desktop and click on View ➔ Projector mode ➔ Swap.*

V. Setting 4:3 Dimension for PowerPoint Prepared Slides

A. To avoid the transfer of Widescreen PowerPoint panels from being cut off in DyKnow session, set your PowerPoint page sizes to 4:3.

1. When preparing your PowerPoint presentation in MS PowerPoint:
   a. Click “Design” from the menu
   b. Click the “Slide Size” down arrow
   c. Select the “Standard (4:3)”
   d. Click on “” to transform your page sizes to the standard
   e. Save your presentation
VI. Working with Prepared Slides

Note: If a slide is "Appended", this means the slide has been sent to the students for viewing and editing.

A. You should now be in a new session with prepared slides.
   1. If not, please follow the directions "Start a DyKnow Session"
B. How to Append a Prepared Slide:
   1. Either double click on the slide in the "filmstrip" on right
   2. or Click the "Append Prepared Slide" ( ) button
C. How to Append a Blank slide:
   1. Click the "Append Blank Slide " ( ) button
D. On the left you will see the Prepared Notebook "Filmstrip"

1. Green under the slide = Has been sent to the students
2. Blue outline = Next slide to be appended using the "Append Next Slide" button ( )
3. Everything else that has not been displayed yet.
VII. Appending Slides to a Notebook

A. **Appending a few slides** (can be done while the session is on)

B. If you are in session and you realize that you want to copy a few slides from another notebook:
   1. Open the notebook that you want to copy slides from
   2. Go to the slide that you want to copy
   3. Right click on the slide
   4. Select “Send Panel to Session” and the slide will be appended to the active session (indicated by the green tab)

*Note: This is the best option if you have a few slides that you want to copy/paste*
C. **Appending an entire slide deck/notebook** (must be done prior to starting a session)

1. Open DyKnow (you do NOT need to login).
2. Click on 'Open Notebook'

3. Once you have opened and converted the slides, click on the DyKnow symbol at the top left of the screen and select “Active Notebook” → “Append Notebook”. Choose the notebook you want to add to your first set of slides.
4. Save the notebook as a DyKnow file.
5. Start your session the regular way and import your saved notebook.
VIII. Changing a Panel Background

A. Right click on the panel

B. Click “Lined Paper”, Graph Paper, Blank, or “Other Backgrounds” to change the background.

C. If you select “Other Backgrounds”, choose a category from the “Categories” drop-down menu and click a background below.

D. Select “OK”
IX. Broadcasting Your Screen

A. This feature is used to present a live view of either the presenting instructor’s workstation or a presenting student’s workstation to the class participants.

   Note: While in Broadcasting Screen mode, a screen shot can be taken and saved to the session notebook.

B. Under “Session” tab, click on the “Broadcast Screen” button.
C. Select the broadcaster by checking either “This Computer” or “Other Participants”.
D. If “This Computer” is checked, the Instructor’s workstations will be broadcast to all.
E. If “Other Participants” is checked, refresh the list of participants connected to the session by clicking on the “Refresh” button.
F. Check the participant whose workstation will be broadcast.
G. It is recommended that you leave the Bandwidth selection to the default selection.
H. Click the “Start Broadcast” button to start the broadcasting.
I. During the broadcasting, you can capture the screen by clicking the camera button or stop the demonstration by clicking on the button shaped like a stop sign.
X. Using Private Ink (Purple Ink)

A. Private ink can be used to write down the correct answer before it is presented onto your slides. Faculty often use this technique for solutions or equations on slides. You can also add personal notes that are invisible to students. If you use Projector Mode, students will be able to see your Purple (Private) ink. You should use a 2nd computer and display the student view if you do not want the students to see your Purple (Private) Ink.

B. On the Home Tab, Select Color/Thickness and chose the Purple (Private) ink.

![Purple Ink Selection](image)

Note: Students can see the instructor’s notes on the instructor’s computer if the instructor connects their device to a projector.
XI. Working with Layers

A. In the event that the moderator’s annotation is written over the student’s annotation or vice versa, i.e. a text collision occurs, both the moderator and the student can hide different layers of content by using the “View” \(\rightarrow\) “Show Layers”.

![Show Layers button in DyKnow](image)

XII. Polling Participants

A. Can be used to quiz or gather opinions from students

1. Prepare a panel with the poll question

2. Click the “Poll Participants” button

[Image of DyKnow interface with污染 Participants button highlighted]
3. In the poll participants window, select the possible answers by checking the appropriate response options (i.e. Multiple Choice, True or False, Yes or No, etc.)

- Can choose to receive answers anonymously
- Can also send a previously made poll

4. Click the “Next” button. You can optionally add a question or answer.
5. After Participants have answered the poll, click the “Results” button to display the responses.

Note: the poll will automatically refresh every few seconds

6. Select between 4 types of results: Table, Pie Chart, Bar Graph, Individual (will show names if ‘anonymous’ option wasn’t selected previously)

7. “Capture” will save the results on the panel (Tip: Add/Append a new panel if there isn’t enough place on present panel. You can use copy/cut/paste to move results)

Note: You need to click anywhere on the panel (outside the poll results) to actually ‘capture the results’ and transmit the results to the students’ computers.
8. Click “Save” to save a copy of the poll results on your local machine (Note: the results are saved in excel format in the ‘My Documents’ folder).
9. Click “Close” closes the poll participant window (Note: once the results are ‘closed’, there is no way to recover the results if they were not saved first).

XIII. Managing Panels

A. This feature is used to manage panels submitted by students or to retrieve panels from students. Once students submit panels, follow the steps under ‘manage panels’ for retrieval.

1. Go to “Session” tab
2. Click the “Manage Panels” button in the ‘Session’ tab (This button may have a red arrow if students have submitted panels that have not been reviewed by the instructor).

![Image of Manage Panels button highlighted]

B. Viewing Student Submitted Panels

1. If students submit panels; use the “Manage Submitted Panel” tab

![Image of Manage Submitted Panels dialog box]

2. Under “Submissions”, click on the student’s name to preview the panel in the “Preview Area”

3. Select the student submissions to append by selecting the check box

4. Under “Documents”, select the documents you which to append to. You can append retrieved panels to a new notebook or append them to an existing one.

*Note: Always append to a new notebook unless you want all the students to get all the retrieved panels*

5. Select “Append”
C. Viewing Retrieved Panels

1. If you want to manually retrieve panels (without students’ knowledge), use the “Retrieve Panels” tab

2. Select the panels you would like to retrieve under “Panels to retrieve”

3. Select the check box of the students you would like to retrieve panels from under “Participants to retrieve from”

4. Check the “Retrieve Panels Anonymously” button if you do not want the names/ids of students to appear at bottom left corner of panel

5. Under “Documents”, select where you want to append the retrieved panels. You can append retrieved panels to a new notebook or append them to an existing one.

   Note: Always append to a new notebook unless you want all the students to get all the retrieved panels

6. Click “Retrieve”
XIV. Returning Panels

A. Once you receive submitted panels or retrieve panels, you can review the work and return the panels.
1. Go to the “Authoring” tab
2. Click on ‘return panels’ to send it back to the student

*Note: Each student gets only their submitted panel back*
XV. Sharing Control

A. Students can act as an instructor where anything he/she writes will appear on all the students’ panels

1. Click the “Share Control” button,
2. In the Share Control window, check the participants to be given control and click “Apply” to give students control of the panel.
3. To disable shared control, uncheck the students who have control and click “Apply”
XVI. Viewing Session List & Requesting Status

A. Click the “Session List” button to open the session list window.

1. The list shows status that the students have selected. The interpretation is shown under “Key”.
2. A request status message can be sent to the students by clicking on the Request Status button.
XVII. Viewing Activity Level

A. Useful for monitoring the engagement of students (Only works with clients running DyKnow 5.5 and above)

1. Click the “Activity Level” button to access this feature

2. The image above shows that student100 has DyKnow as their top window (indicated by the ✓ beside their name), while student101 is currently looking at another application on their computer with DyKnow in the background (indicated by the ✗ beside their name).

Note: This will be a good time to poll participants and a significant number of students are not actively engaged in the lecture.
XVIII. Creating Work Groups

A. In the “Session” tab, click the “Work in Groups” button to open work group window.

1. Click the “Refresh” button to update the list of participants in the session.
2. Under the “Participants Not In Work Groups” tab, select the students you want to put in one particular group.
3. Click the “New Group” button to create the group.
4. Click the “Save” button to save the group.
5. Click the “Load” button to load and then click “Apply” and “OK” to activate the group. All the students in the group now share their panels. The number of shared panels in the group can be restricted by specifying under “Work Groups Panel Limitations”. To do this, check the “Limit Work Group Collaboration to Panels” and specify the panels to be limited.
6. Random Groups can be created as specified under the “Random Work Groups” section. To do this, specify the “Number of Work Groups” and click the “Random” button to create the groups. Click the “Load” button to load and then click the “Apply” and the “OK” to activate the group.
7. It is also possible to un-group and to delete groups
XIX. Sharing a Notebook

A. Used to share a DyKnow notebook with students
   1. To save notebook, click on "Save"
   2. Click "DyKnow Server"
   3. Select the course
   4. Click “Open” to save the notebook
5. Name the notebook file
6. Click “Save”

7. Click on “My DyKnow” tab
8. Click on the course name
9. Check the box of the notebook you would like to share

10. Click “Share Selected” at the bottom of the screen

11. You can unshared a notebook at any time by selecting the shared notebook and clicking “Unshare Selected” at the bottom of the screen

Note: If your students cannot see all of your panels in the shared notebook, try appending all of your prepared panels by clicking the “Append Prepared Slide” button for each panel prior to saving the notebook. SHARED NOTEBOOKS SHOW PURPLE INK.
XX. Saving a Notebook

A. **DyKnow Server** (Only accessible if connected to the internet)
   1. Click → “Save” → “DyKnow Server”
   2. Double-click on course folder if you are not already in it
   3. Name the notebook and click “Save”

![Save As dialog box]

B. **Local Computer** (Accessible Offline) **Saved as Dyknow File** (filename.dyz)
   1. Click → “Save”
   2. Choose a folder on your computer to save your notes in
   3. Name the notebook and click “Save”

Note: If notes from DyKnow are ever needed offline, on a device that does not have DyKnow software, or after the class has been removed from DyKnow, saving a PDF version of the notes would be good practice.

A. **Local Computer (Accessible Offline) Saved as PDF**
   1. Click → “Print”
2. Under “Printers”, click on the “Name” dropdown.
3. Choose either “Microsoft Print to PDF” or “Print to PDF Annotator” (if PDF Annotator is installed on your device).
4. Change any other options if necessary, the click “OK”
5. For “Microsoft Print to PDF”, this will prompt a “Save Print Output As” window. Chose a destination and filename, then click “Save”.
6. For “Print to PDF Annotator”, the created PDF will open in a PDF Annotator window. From there you can make edits and save.

C. Printing to OneNote

1. Click "Print"
2. Choose OneNote as your printer

*Note: “Four panels to a page” allows your note slides and your private notes to print side-by-side.
3. Click “OK”

*Note: OneNote will open a menu to ask where you’d like to save the notes
XXI. Retrieving a Notebook Saved on the Server

A. Click on “My DyKnow” tab
B. Click on the appropriate course name
C. Click the notebook you want to open

Note: Panels that you, as an Instructor, returned to your students can be accessed here inside a notebook usually labeled “Returned Work <date>” unless you give it a different name.

XXII. Using DyKnow Notebook Writer

D. The Notebook Writer is a tool used to convert a non-PowerPoint file to a DyKnow.dyz file format. The tool is available for both 32-bit and 64-bit versions of Windows 7 and above. Make sure that you download the appropriate version for your operating system. An instructional tutorial about using Notebook Writer can be found at http://eng.vt.edu/it/dyknow.
XXIII. Additional Help:

A. Refer to Dyknow Desktop Support at: https://support.dyknow.com/hc/en-us
B. Email engtechteam@vt.edu
C. If you ever wish to provide us with critiques on this tutorial, please do not hesitate to email us at the email above.